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Technology Licenses

The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license.

U.S Government Rights

The Software is “commercial 
computer software,” as defined by 
Federal Acquisition Regulation (“FAR”) 
2.101. Pursuant to FAR 12.212 and 
27.405-3 and Department of Defense 
FAR Supplement (“DFARS”) 227.7202, 
the U.S. government acquires 
commercial computer software under 
the same terms by which the software 
is customarily provided to the public. 
Accordingly, Keysight provides the 
Software to U.S. government 
customers under its standard 
commercial license, which is 
embodied in its End User License 
Agreement (EULA), a copy of which 
can be found at 
http://www.keysight.com/find/sweula

The license set forth in the EULA 
represents the exclusive authority by 
which the U.S. government may use, 
modify, distribute, or disclose the 
Software. The EULA and the license 
set forth therein, does not require or 
permit, among other things, that 
Keysight: (1) Furnish technical 
information related to commercial 
computer software or commercial 
computer software documentation 
that is not customarily provided to the 
public; or (2) Relinquish to, or 
otherwise provide, the government 
rights in excess of these rights 
customarily provided to the public to 
use, modify, reproduce, release, 
perform, display, or disclose 
commercial computer software or 
commercial computer software 
documentation. No additional 
government requirements beyond 
those set forth in the EULA shall apply, 
except to the extent that those terms, 
rights, or licenses are explicitly 
required from all providers of 
commercial computer software 
pursuant to the FAR and the DFARS 
and are set forth specifically in writing 
elsewhere in the EULA. Keysight shall 
be under no obligation to update, 
revise or otherwise modify the 
Software. With respect to any 
technical data as defined by FAR 
2.101, pursuant to FAR 12.211 and 
27.404.2 and DFARS 227.7102, the 
U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as 
applicable in any technical data.

Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED “AS IS,” AND IS 
SUBJECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, TO 
THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL 
WARRANTIES, EITHER EXPRESS OR IMPLIED, 
WITH REGARD TO THIS MANUAL AND ANY 
INFORMATION CONTAINED HEREIN, 
INCLUDING BUT NOT LIMITED TO THE 
IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE FOR 
ERRORS OR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES IN CONNECTION 
WITH THE FURNISHING, USE, OR 
PERFORMANCE OF THIS DOCUMENT OR OF 
ANY INFORMATION CONTAINED HEREIN. 
SHOULD KEYSIGHT AND THE USER HAVE A 
SEPARATE WRITTEN AGREEMENT WITH 
WARRANTY TERMS COVERING THE MATERIAL 
IN THIS DOCUMENT THAT CONFLICT WITH 
THESE TERMS, THE WARRANTY TERMS IN 
THE SEPARATE AGREEMENT SHALL CONTROL.

Safety Information

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula
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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these 
products, including instrument software upgrades, application information, and 
product information, navigate to the URL above, then in the Support by Product 
Model Number box, enter the Product Number of your instrument (for example, N9030A) 
and click Find.

To receive the latest updates by email, subscribe to Keysight Email Updates:

http://www.keysight.com/find/emailupdates

Information on preventing instrument damage can be found at:

http://www.keysight.com/find/PreventingInstrumentRepair

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate 
product enhancements. To search for software updates for your product, go to the 
Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
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1 Contacting Keysight Sales and Service Offices

Assistance with test and measurement needs, and information to help you find 
a local Keysight office, is available via the internet at, 
http://www.keysight.com/find/assist. If you do not have internet access, 
please contact your designated Keysight representative.

  N O T E   In any correspondence or telephone conversation, refer to the instrument by 
its model number and full serial number. With this information, the Keysight 
representative can determine whether your unit is still within its warranty 
period.

http://www.keysight.com/find/assist
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2 Products Covered by this Document

This document describes instrument memory types and security features. It 
provides a statement regarding the volatility of all memory types, and specifies 
the steps required to declassify an instrument through memory clearing, 
sanitization, or removal. 

For additional information, go to:

http://www.keysight.com/find/security

 IMPORTANT Be sure that all information stored by the user in the instrument that needs to 
be saved is properly backed up before attempting to clear any of the 
instrument memory. Keysight Technologies cannot be held responsible for 
any lost files or data resulting from the clearing of memory. 

Be sure to read this document entirely before proceeding with any file 
deletion or memory clearing.

Product Family Name Product Names Model Numbers

X-Series Signal Analyzers PXA Signal Analyzer N9030A

MXA Signal Analyzer N9020A

EXA Signal Analyzer N9010A

CXA Signal Analyzer N9000A
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Products Covered by this Document
X-Series Processor and Disk Drive Configurations

X-Series Processor and Disk Drive Configurations
This document describes alternative Processor and Disk Drive Configurations 
for X-Series analyzers. Due to continuous improvement of the X Series 
Analyzer range, configurations may vary according to such factors as: 
manufacturing date, product name, and installed options. Processor and disk 
drive configurations are considered separately, due to the large number of 
possible combinations.

The installed memory components, and the procedures for sanitization of the 
instrument’s memory, differ according to the processor and disk drive 
configurations. Therefore, to identify the correct information and procedures for 
your instrument, you need to determine its Processor Assembly Configuration 
and Disk Drive Configuration.

Processor Assembly Configuration
There are several possible processor assembly configurations: older 
configurations have a non-removable (fixed) disk drive, while newer 
configurations have a removable disk drive. The relationship between 
processor assembly type and product name is detailed in Table 2-1 below. (For 
details of how to determine installed options, see “Determining Installed 
Options” on page 13)

Table 2-1 Processor Assembly & Product Name

Type Configuration Product Names & Installed Options

1 Fixed Disk The disk is referred to as "fixed", because it can only be removed by removing 
and opening the instrument’s processor assembly. 

This configuration is standard for:

a. MXA instruments without Option PC2, PC4 or PC6(S),

b. EXA instruments without Option PC2, PC3, PC4, PC5, PC6(S) or PC7(S),

c. CXA instruments without Option PC3, PC5 or PC7(S)

2 Removable Disk The disk may be removed from the instrument’s rear panel, without removing 
or opening the processor assembly.

This configuration is standard for:

a. All PXA instruments,

b. MXA instruments with Option PC2, PC4 or PC6(S),

c. EXA instruments with Option PC2, PC3, PC4, PC5, PC6(S) or PC7(S),

d. CXA instruments with Option PC3, PC5 or PC7(S)
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Disk Drive Configuration
There are several possible disk drive configurations, as listed below in Table 
2-2. The actual configuration depends on the instrument’s Product Name and 
installed options. For details of how to determine installed options, see 
“Determining Installed Options” on page 13.

For details of the capacities of each of the drive types listed below, see 
“Non-Volatile Memory” on page 18.

Option SSD You can obtain a Removable Solid-State disk drive for your instrument, either 
as an upgrade to replace a Removable Magnetic disk drive, or as an additional 
solid-state drive, by ordering Option SSD. You can order Option SSD either at 
the time that you purchase the instrument, or at any later time. 

If your instrument’s current processor assembly configuration is Fixed Disk, in 
order to be able to use the removable disk you will need to upgrade the 
instrument to a Removable Disk, by ordering Option PC6 or PC7 as 
appropriate. (Older CXA instruments may require Option PC5 instead of PC7. 
Before ordering, check with your Keysight Sales office, as described in 
“Contacting Keysight Sales and Service Offices” on page 6.)

Note that Removable Solid-State disk units exist in various capacities, ranging 
from 32 GB to 256 GB (or greater).

Table 2-2 Disk Drive Configurations

Type Configuration Product Names & Installed Options

Fixed Magnetic Fixed Magnetic Drive This configuration applies to:

a. MXA instruments without Option PC2 or PC4,

b. EXA instruments without Option PC2, PC3, PC4 or PC5,

c. CXA instruments without Option PC3 or PC5.

Removable 
Magnetic

Removable Magnetic Drive This configuration applies to:

a. PXA instruments without Option SSD,

b. MXA instruments with Option PC2, but without Option SSD. 

c. EXA instruments with Option PC2 or PC3, but without Option 
SSD.

(To determine whether your instrument includes Option SSD, which is 
now included with new instruments by default, see “Determining 
Installed Options” on page 13.)

Removable 
Solid-State

Removable Solid-State Drive

(Flash drive)

This configuration applies to all instruments with Option SSD, Option 
PC4, PC5, PC6(S) or PC7(S).

Originally an option, a solid-state disk drive cartridge is now supplied 
by default with X-Series Analyzers.
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Determining Instrument Configuration based on Product Name
Use the following procedures to determine the processor assembly and disk 
drive configurations of your instrument, starting from its Product Name.

Processor Assembly Configuration
The following procedure allows you to determine whether your instrument has 
a Fixed Disk or Removable Disk processor assembly.

Disk Drive Configuration
The following procedure allows you to determine your instrument’s disk drive 
configuration

Step Procedure

1 What is the Product Name of your instrument?

— PXA: Your instrument has a Removable Disk processor assembly.

— MXA, EXA, CXA: Go to Step 2.

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on 
page 12. Does it resemble Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

— Fixed Disk: Your instrument has a Fixed Disk processor assembly.

— Removable Disk: Your instrument has a Removable Disk processor assembly

Step Procedure

1 What is the Product Name of your instrument?

— PXA: Go to Step 4

— MXA, EXA: Go to Step 3

— CXA: Go to Step 2

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on 
page 12. Does it resemble or Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

— Fixed Disk: Your instrument has a 40 GB Fixed Magnetic disk drive.

— Removable Disk: Your instrument has a Removable Solid-State disk drive., with capacity in 
the range from 32 GB to 256 GB

3 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on 
page 12. Does it resemble or Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

— Fixed Disk: Your instrument has a 40 GB Fixed Magnetic disk drive.

— Removable Disk: Go to Step 4.
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4 Check the instrument’s installed options (see “Determining Installed Options” on page 13).

— If the list includes N90X0A-IDE, your instrument has a 160 GB Removable Magnetic disk drive.

— If the list includes N90X0A-SSD, your instrument has a Removable Solid-State disk drive, with 
capacity in the range from 32 GB to 256 GB.

Step Procedure
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Rear Panel Configurations

Figure 2-1 Rear Panel of Instrument with Fixed Magnetic Disk
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Figure 2-2 Rear Panel of Instrument with Removable Magnetic or Removable Solid-State 
Disk

Determining Installed Options
Use the following procedure to determine whether your instrument has a 
magnetic or solid-state disk drive, and whether any of Options PC2 through 
PC7 are installed.

1. Using the instrument front panel and softkey menus, press System > Show > 
System.

2. The Show System display appears. Look for start of the Option listing, a few lines 
below the top of the table, as shown in Figure 2-3 below.
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Figure 2-3 Show System Display: Option Listing

3. The entries under the Option heading have the significance described in Table 2-3.

4. To dismiss the Show System display, press any other front-panel or menu key.

Table 2-3 Interpretation of Option Items

Listing Identifier Installed Option

N90X0A-SSDa A Removable Solid-State disk drive is installed (either because the 
instrument was supplied with this drive, or because Option SSD has 
been installed)

N90X0A-IDEa A Fixed Magnetic disk drive is installed, as shown in the example in 
Figure 2-3 above

N90X0A-PC1a A Fixed Magnetic disk drive is installed

N90X0A-PC2a A Removable Magnetic or Removable Solid-State disk drive is installed

N90X0A-PC3a A Removable Magnetic or Removable Solid-State disk drive is installed

N90X0A-PC4a

N90X0A-PC5a

N90X0A-PC6a

N90X0A-PC6Sa

N90X0A-PC7a

N90X0A-PC7Sa

A Removable Solid-State disk drive is installed
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a. "X" is a digit between 0 and 3, according to the Model Number
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3 Security Terms and Definitions

Term Definition

Clearing As defined in Section 5 of NIST SP 800-88, Revision 1, Guidelines for Media Sanitization, Clearing is 
a sanitization method by which classified information in user-addressable storage space on the 
media is overwritten with non-sensitive data, using the standard read and write commands for the 
device. 

Hence, clearing is typically used when the instrument is to remain in an environment with an 
acceptable level of protection.

Instrument 
Declassification

A term that refers to procedures that must be undertaken before an instrument can be removed 
from a secure environment (aka controlled area), such as is the case when the instrument is 
returned for calibration. Declassification procedures include memory sanitization or memory 
removal, or both.

Sanitization Sanitization methods are defined and discussed in NIST SP 800-88, Revision 1, Guidelines for 
Media Sanitization. In that document, Purging is defined as a method by which classified 
information is completely removed from memory, or the memory is destroyed, so that even a 
laboratory attack using known techniques or analysis will not recover any information. 

In this document, the term Sanitization is reserved for the Purge Sanitization method described 
in the NIST document.

Hence, instrument sanitization is typically required when an instrument is moved from a secure to a 
non-secure environment, such as when it is returned to the factory for calibration.

Keysight memory sanitization procedures are designed for customers who need to meet the 
requirements specified by the US Defense Security Service (DSS). These requirements are specified 
in the “Media Sanitization Matrix” in Appendix T of the Defense Security Service (DSS) Assessment 
and Authorization Process Manual (DAAPM).

Secure Erase Secure Erase is a term that is used to refer to either the clearing or sanitization features of Keysight 
instruments.
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4 Instrument Memory & Volatility

This chapter summarizes all memory types in the instrument, for the following 
processor assembly and disk drive configurations:

a. Fixed Disk processor assemblies,

b. Removable Disk processor assemblies.

For definition of terms, and to determine the configuration of your instrument, 
based on its Product Name and installed options, see “X-Series Processor and 
Disk Drive Configurations” on page 8.

The descriptions below are divided between:

1. Non-Volatile Memory,

2. Volatile Memory.
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Instrument Memory & Volatility
Non-Volatile Memory

Non-Volatile Memory
This section contains information on the memory components available in your 
instrument. 

— “Components for All Instruments” on page 19

— “Additional Components for PXA and some MXA Instruments” on page 24

— “Additional Components for Instruments with PC6, PC7, PC6S, and PC7S 
Processor Assemblies” on page 26

All tables provide details of the size of each memory component, its type, how 
it is used, its location, volatility, and the sanitization procedure.

  N O T E   The instrument contains no user-accessible non-volatile memory, except for 
the Disk Drive described in Item 1 of Table 4-1 and the SD Memory Card 
described in Table 4-3. For this reason, as indicated in the tables below, no 
sanitization procedure is required for any memory component except the Disk 
Drive and SD Memory Card.
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Instrument Memory & Volatility
Non-Volatile Memory

Components for All Instruments

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)

Memory 
Component, 
Type and Size
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Purpose/Contents Data Input Method Location in 
Instrument and 
Remarks

Sanitization 
Procedure

1. Disk Drive

Fixed Magnetic: 
40 GByte

Removable 
Magnetic: 
160 GByte

Removable 
Solid-State: 
Capacity Varies, 
32 GByte - 
256 GByte

This drive is 
partitioned, as 
detailed in “Disk 
Drive 
Partitioning” on 
page 27.

Yes Yes Contains operating 
system, Instrument 
Software, Factory 
Calibration Data, 
Diagnostic software, 
Crash recovery image, 
user instrument states, 
user data files, user trace 
data and any user 
installed third party 
software.

Programmed 
before installation 
or by 
factory/service 
center calibration 
procedure 
software, or by 
upgrade 
installation 
software. Also 
programmed via 
operations and by 
the user.

Fixed Disk: A4 
Processor Assy.

Removable Disk: 
Rear Panel 
(Removable)

Contains user 
data.

See Table 5-1 
on page 30.

2. CPU BIOS 

(CMOS NVRAM)

256 Byte

(battery backed)

No Yes Contains default BIOS 
settings to use when 
booting the Processor 
Assembly.

Programmed by 
factory. Settings 
can be toggled by 
user.

A4 Processor 
Assy.

Battery backed 
to maintain 
Windows 
calendar time.

Contains no 
user data.

None.

3. License 
Storage Memory

(EEPROM)

512 kbit

No Yes Contains instrument 
serial number and 
license keys for 
measurement 
applications. License 
keys are encrypted. 

Programmed 
before installation 
and by installing 
new license keys.

A7 Midplane 
Assy.

Contains no 
user data.

None.
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Non-Volatile Memory

4. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A14 Synthesizer 
Assy.

Contains no 
user data.

None.

5. Config Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A14 Synthesizer 
Assy.

Contains no 
user data.

None.

6. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A15 Front End 
Control Assy.

Contains no 
user data.

None.

7. Config Memory 

(Flash)

2 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up. Primarily YTF, 
attenuator, and front end 
switch control.

Programmed 
before installation.

A15 Front End 
Control Assy.

Contains no 
user data.

None.

8. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A2 Analog IF 
Assy.

Contains no 
user data.

None.

9. Control Logic 
Memory

(CPLD)

1600 Gates

No Yes Contains control 
algorithms to optimize 
filter performance.

Programmed 
before installation.

A2 Analog IF 
Assy.

Contains no 
user data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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Instrument Memory & Volatility
Non-Volatile Memory

10. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A3 Digital IF 
Assy.

Contains no 
user data.

None.

11. Config 
Memory 

(Flash)

8 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A3 Digital IF 
Assy.

Contains no 
user data.

None.

12. Control Logic 
Memory 

(CPLD)

6400 Gates

No Yes Contains measurement 
and control algorithms to 
optimize digital filtering.

Programmed 
before installation.

A3 Digital IF 
Assy.

Contains no 
user data.

None.

13. Serial 
Presence Detect 
Memory

(EEPROM)

2 Mbit

No Yes Used on commercial 
SDRAM Module, 
programmed by chip 
vendor. Contains module 
identification information. 

Programmed by IC 
vendor only.

A3 Digital IF 
Assy.

Contains no 
user data.

None.

14. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A16 Reference 
Assy.

Contains no 
user data.

None.

15. FPGA Config 
Memory

(EEPROM)

2 Mbit

No Yes Contains measurement 
and control software.

Programmed 
before installation.

A16 Reference 
Assy.

Contains no 
user data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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Non-Volatile Memory

16. Digital 
Potentiometer

 (EEPROM)

112 bits

(14 Bytes) 

No Yes Contains default data to 
preset digital 
potentiometers during 
power-up. 

Programmed 
before installation.

A16 Reference 
Assy.

Contains no 
user data.

None.

17. Front Panel 
EEPROM

64 kbit

No Yes Contains software for 
running front panel 
microcontroller. Operates 
front panel LEDs, and 
transmits key presses to 
processor.

Programmed 
before installation.

A1A2 Front 
Panel Interface 
Board

Contains no 
user data.

None.

18. Front Panel 
CPLD

800 Gates

No Yes Contains fixed digital 
logic associated with 
front panel keyboard 
button operation and 
LEDs.

Programmed 
before installation 
at the factory only.

A1A2 Front 
Panel Interface 
Board

Contains no 
user data.

None.

19. EDID Memory

(EEPROM)

2 kbit

No Yes Extended Display 
Identification Data is a 
VESA standard data 
format that contains 
basic information about a 
monitor and its 
capabilities, including 
vendor information, 
maximum image size, 
color characteristics, 
factory pre-set timings, 
frequency range limits, 
and character strings for 
the monitor name and 
serial number.

Programmed 
before installation.

A1A2 Front 
Panel Interface 
Board.

Contains no 
user data.

None.

20. A11 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A11 Low Band 
Switch.

Contains no 
user data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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21. A12 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A12 YTF 
Assembly.

Contains no 
user data.

None.

22. A13 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed 
before installation.

A13 Front End 
Assembly.

Contains no 
user data.

None.

23. A18 Header 
Memory.

(EEPROM)

8 kbit

No Yes Contains header 
information used to 
identify the assembly.

Programmed 
before installation.

A18 BBIQ 
Connector 
Assembly.

Contains no 
user data.

None.

24. A19 Header 
Memory.

(EEPROM)

8 kbit

No Yes Contains header 
information used to 
identify the assembly.

Programmed 
before installation.

A19 BBIQ Main 
Assembly.

Contains no 
user data.

None.

25. Config 
Memory

(Flash)

2 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A19 BBIQ Main 
Assembly.

Contains no 
user data.

None.

26. Config 
Memory

(Flash)

32 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A19 BBIQ Main 
Assembly.

Contains no 
user data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and 
Dual-Core Processors)
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Additional Components for PXA and some MXA Instruments
In Table 4-2 below, refer to the footnotes to determine to which model number 
a particular component applies.

Table 4-2 Summary of Non-Volatile instrument memory - Additional Components for all PXA 
Instruments and some MXA Instruments
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1. Boot ROM

(Flash)

8 MByte

No Yes Contains the boot ROM, 
operating system and 
run-time code for the 
WBDIF CPU.

Programmed by 
factory at 
installation time, or 
during firmware 
upgrade.

A26 WBDIF 
assemblya

Contains no 
user data.

None.

2. (Flash) 

16 MByte

(2 x 64 Mbit)

No Yes Contains up to 3 WBDIF 
FPGA images.

Programmed by 
factory at 
installation time, or 
during FPGA 
upgrade process.

A26 WBDIF 
assemblya

Contains no 
user data.

None.

3. (EEPROM) 

512 Byte

No Yes Contains header 
information used to 
identify the assembly, 
and configuration 
information used to 
initialize the PCI bus.

Programmed 
before installation.

A26 WBDIF 
assemblya

Contains no 
user data.

None.

4. (EEPROM)

1024 byte 

No Yes Contains configuration 
information used during 
initialization of the PCI 
bus. 

This component is 
currently unprogrammed.

Programmed 
before installation.

A26 WBDIF 
assemblya

Contains no 
user data.

None.

5. (CPLD)

256 Macrocells

No Yes Contains critical 
hardware control 
algorithms.

Programmed 
before installation.

A26 WBDIF 
assemblya

Contains no 
user data.

None.
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6. A16A1 Header 
Memory

(EEPROM)

8 kbit

No Yes Contains header 
information used to 
identify the assembly.

Programmed 
before installation.

A16A1 
Reference 
Daughter 
Assemblyb

Contains no 
user data.

None.

7. Config 
Memory

(Flash)

1 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A16A1 
Reference 
Daughter 
Assemblyb

Contains no 
user data.

None.

8. A25 Header 
Memory

(EEPROM)

8 kbit

No Yes Contains header 
information used to 
identify the assembly.

Programmed 
before installation.

A25 WBAIFa

Contains no 
user data.

None.

9. Control Logic 
Memory

(CPLD)

1600 Gates

No Yes Contains control 
algorithms.

Programmed 
before installation.

A25 WBAIFa

Contains no 
user data.

None.

10. Config 
Memory

(Flash)

2 Mbit

No Yes Contains measurement 
and control software, 
which is preloaded into 
FPGA during instrument 
power-up.

Programmed 
before installation.

A25 WBAIFa

Contains no 
user data.

None.

a. Present in all PXA and MXA instruments with Option B85, B1A or B1X
b. Present in all PXA instruments, all MXA instruments with serial numbers higher than or equal to 

MY/SG/US5233, and MXA instruments with serial numbers lower than MY/SG/US5233, but with 
Options B85, B1A or B1X.

Table 4-2 Summary of Non-Volatile instrument memory - Additional Components for all PXA 
Instruments and some MXA Instruments
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Additional Components for Instruments with PC6, PC7, PC6S, and 
PC7S Processor Assemblies

The components listed below are included only in some instruments, To 
determine your instrument’s configuration, see“Determining Installed Options” 
on page 13.

Table 4-3 Summary of Non-Volatile instrument memory - Additional Components for 
instruments with PC6, PC7, PC6S, and PC7S Processor Assemblies
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1. SD Memory 
Card

16 GByte

Yes Yes Calibration database file 
backup

Programmed by 
instrument 
software and by the 
user

A4 Processor 
Assy

Contains user 
data.

See Table 5-4 
on page 32.

2. SD card 
controller 
configuration 
memory

2 Kbit EEPROM

No Yes Configuration for the SD 
card controller on boot 
up

Programmed 
before installation

A4 Processor 
Assy

Contains no 
user data

None

3. PCIe retimer 
configuration

8 Kbit EEPROM

No Yes Configuration for the 
PCIe retimer for external 
PCIe communication

Programmed 
before installation

A4 Processor 
Assy

Contains no 
user data

None

4. Calibration 
Backup memory

1 Gbit Flash

Noa Yes Calibration data backup Programmed by 
instrument 
software

A4 Processor 
Assyb

Contains no 
user data

None

a. Accessible only via a Keysight-provided utility, which permits only storage and retrieval of calibration 
data.

b. Present only in instruments with PC6S or PC7S Processors.
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Disk Drive Partitioning
The instrument’s disk drive is divided at the factory into three visible partitions, 
labeled C:, D: and E:, plus a fourth hidden partition. 

The sizes of each partition vary according to the instrument’s Disk Drive 
Configuration.

Details of the partition functions are provided in Table 4-4 below.

Table 4-4 Disk Drive Partitions

Partition Label Purpose

C: Primary partition for applications and secondary data.

D: Default location for user data.

E: Calibration data.

Hidden Factory recovery image of the C: partition.



Security Features & Document of Volatility                                                                                                         28

Instrument Memory & Volatility
Volatile Memory

Volatile Memory
The volatile memory in the instrument does not have battery backup. It does 
not retain any information when AC power is removed. 

Removing power from this memory meets the memory sanitization 
requirements specified in the “Media Sanitization Matrix” in Appendix T of the 
Defense Security Service (DSS) Assessment and Authorization Process Manual 
(DAAPM).

Table 4-5 Summary of Volatile Instrument Memory - Instruments with Single-Core and 
Dual-Core Processors
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1. Processor 
SDRAM

Fixed Disk: 
1 GByte or 
2 GByte

Removable Disk: 
From 4 GByte to 
16 GByte

Yes No Main dynamic RAM 
memory for processor. 

Contains working 
copies of operating 
system, instrument 
measurement 
applications, 
calibration data, and 
measurement data.

Programmed before 
installation, or by 
factory/service 
center calibration 
procedure software, 
or by firmware 
upgrade installation 
software.

Also programmed 
via firmware 
operations and by 
user.

A4 Processor 
Assy.

Contains user 
data.

Turn off 
instrument 
power.a

2. SDRAM

256 MByte

Yes No Contains measurement 
data from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by user.

A3 Digital IF 
Assy.

Contains raw 
measurement 
data.

Turn off 
instrument 
power.a

3. SDRAM

2 GByte

Yes No Contains measurement 
data from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by user.

A3 Digital IF 
Assy. 

For all N9030A 
instruments, and 
instruments with 
Options DP2, 
B40, MPB

Contains raw 
measurement 
data.

Turn off 
instrument 
power.a
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4. SDRAM

2 GByte Module

Yes No Contains measurement 
data from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by user.

A26 Wideband 
Digital IF Assy.b

Contains raw 
measurement 
data.

Turn off 
instrument 
power.a

5. SDRAM

4 GByte Module

Yes No Contains measurement 
data from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by user.

A26 Wideband 
Digital IF Assy.c

Contains raw 
measurement 
data.

Turn off 
instrument 
power.a

6. SDRAM

256 MByte 
Module

Yes No Contains measurement 
data from data 
acquisition system.

Programmed by 
firmware. Not 
accessible by user.

A26 Wideband 
Digital IF Assy.d

Contains raw 
measurement 
data.

Turn off 
instrument 
power.a

a. This memory is not battery backed-up or connected to standby power.
b. Resident in instruments that meet these criteria:
1. Contains Option DP2,
2. Does not contain Option DP4,
3. Contains one or more of Options B85, B1A, or B1X
c. Resident in all instruments that contain Option DP2 and one or more of Options B85, B1A, or B1X
d. Resident in instruments that contain Options B1A, B1X, or B85.

Table 4-5 Summary of Volatile Instrument Memory - Instruments with Single-Core and 
Dual-Core Processors
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5 Memory Sanitization and Removal Procedures

This section explains how to clear, sanitize, and remove memory from your 
instrument, for all types of non-volatile memory that can be written to during 
normal instrument operation.

Table 5-1 Disk Drive

Description and 
purpose

The Disk Drive is the main memory for the instrument. It has very large storage capacity, plus 
fast read and write times. There are no limitations on the number of read/write cycles.

It contains the operating system, Instrument Software, Factory Calibration Data, Diagnostic 
software, Crash recovery image, user instrument states, user data files, user trace data and any 
user-installed third party software. The Disk Drive is written to frequently by the operating 
system and other application software.

Size Fixed Magnetic magnetic disk drive: 40 Gigabytes

Removable Magnetic disk drive: 160 Gigabytes

Removable Solid-State disk drive: capacity from 32 Gigabytes to 256 Gigabytes

Memory clearing Software utilities are available that comply with the clearing requirements specified for 
Magnetic Disks and Flash Drives in the “Media Sanitization Matrix” in Appendix T of the Defense 
Security Service (DSS) Assessment and Authorization Process Manual (DAAPM).

Memory sanitization We recommend always removing the Disk Drive to achieve sanitization. 

For program classifications lower than Top Secret, the disk can be sanitized using method "d" 
(for magnetic disks) or method "c" followed by "h" (for solid-state drives) as defined in the 
"Media Sanitization Matrix" in Appendix T of the Defense Security Service (DSS) Assessment 
and Authorization Process Manual (DAAPM)“. 

For Top Secret and higher program classifications, Disk Drive removal is the only acceptable 
sanitization procedure. 

Memory removal Fixed Disk Processor assembly: see “Instruments with Non-Removable Drives” on page 53, in 
the Chapter "Disk Drive Removal Procedure".

Removable Disk Processor assemblies: see “Instruments with Removable Drives” on page 55, in 
the Chapter "Disk Drive Removal Procedure".

Write protecting The Disk Drive cannot be write protected. The operating system and software must be able to 
read from and write to the drive during normal operation.

Memory validation The Disk Drive memory can be validated using third-party Windows utilities.
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Table 5-2 CPLD, CMOS Programmable Logic Devices

Description and 
purpose

These memory devices are used to execute timing, control, and measurement functions. No 
user data is contained in these devices. This memory cannot be written to during instrument 
operation.

Size 1600 to 6400 logic gates.

Memory clearing Not applicable. This memory does not contain user information and is not accessible by the 
user.

Memory sanitization Not applicable. This memory does not contain user information and is not accessible by the 
user.

Memory removal Not applicable. 

Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks These devices are programmed in the factory via diagnostic connectors on the PCB assemblies. 
After instrument assembly, the diagnostic connectors are not physically accessible and not 
electrically connected. 

Table 5-3 EEPROM Memories

Description and 
purpose

These memories are used to identify the assemblies (header info) and store option configuration 
data. Some are also used to hold factory software for FPGAs. The software is loaded when the 
instrument powers up. This memory cannot be written to during instrument operation.

Size 2 kbit to 8 Mbit

Memory clearing Not applicable. This memory does not contain user information and is not accessible by the 
user.

Memory sanitization Not applicable. This memory does not contain user information and is not accessible by the 
user.

Memory removal Not applicable. 

Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks With one exception, as described below, these memories are only writable by factory/service 
center software, or upgrade installation software. These memories are internally connected to 
proprietary internal control data busses (as opposed to standard computer busses such as IDE, 
PCI, USB). They are not accessible by the operating system or by third-party software, or by the 
user, to protect the measurement accuracy and consistency of the instrument. They are rarely 
modified, to ensure no degradation of instrument performance. These memories contain no 
user data. Many of these memories have long write times, and limited write endurance, so they 
are not intended to be written to dynamically by software.

The sole exception applies to the EEPROM on the A7 Midplane Assembly. Inserting a USB 
memory device containing a valid license key file into the instrument causes the key file to be 
copied to both the C: drive and the EEPROM on the A7 Midplane Assembly. 
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Table 5-4 SD Memory Card

Description and 
purpose

The intended purpose of the SD Memory Card is for backing up the instrument calibration database 
file. The backup and restore process used by the instrument will default to this location.

Users can also write to this memory, since it appears as another disk drive to the instrument.

Size 16 Gigabytes

Memory clearing Software utilities are available that comply with the clearing requirements specified for Flash Drives 
in the “Media Sanitization Matrix” in Appendix T of the Defense Security Service (DSS) Assessment 
and Authorization Process Manual (DAAPM).

Memory 
sanitization 

We recommend always removing the SD Memory Card to achieve sanitization.

For program classifications lower than Top Secret, this media type can be sanitized using the 
methods defined in the "Media Sanitization Matrix" in Appendix T of the Defense Security Service 
(DSS) Assessment and Authorization Process Manual (DAAPM)“. 

For Top Secret and higher program classifications, SD Card removal is the only acceptable 
sanitization procedure. 

Memory removal See the Chapter “SD Memory Card Removal Procedure” on page 57.

Write protecting The SD Memory Card can be write protected by the use of a switch located on the card itself. Write 
protecting the card does not interfere with the normal operation of the instrument operating system 
or the instrument application software.

Memory 
validation

The SD Memory Card can be validated using third-party Windows utilities.
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Instrument Sanitization Procedures
This section includes flowcharts that describe how to sanitize an instrument by 
physical removal and replacement of either the Processor Assembly or Disk 
Drive.

— For Fixed Disk instruments, see “Replacement of Processor Assembly” on 
page 33.

— For Removable Disk instruments, see “Replacement of Disk Drive 
(Instruments without PC6S/PC7S)” on page 34 or “Replacement of Disk 
Drive (Instruments with PC6S/PC7S)” on page 37 as appropriate for your 
instrument.

Application License Key Storage
Note that License keys are stored in EEPROM on the A7 Midplane Assembly (as 
described in Item 3 of Table 4-1 on page 19). Therefore, when replacing either 
the Processor Assembly or Disk Drive, you usually do not need to back up and 
restore the license keys.

Replacement of Processor Assembly
This procedure applies only to Fixed Disk instruments.

Note that this procedure differs from that for replacement of the Disk Drive 
only in that the entire Processor Assembly is replaced.

Items Required

To perform these tasks in a controlled area, you will need:

— 1x Instrument

— 2x Processor Assemblies for the instrument

— 1x One-time writable media, plus 1x compatible writing device for the 
non-controlled area and 1x reading device for the controlled area. See 
“Selection of USB Memory Device” on page 42 for details.

Procedure

Steps below that appear on a yellow background take place in the controlled 
area. All other steps take place in a non-controlled area.

Step Task

1 Receive new or recalibrated instrument from factory/service center.

2 Archive calibration files from Disk Drive to portable media.

For details of the procedure, see “Archiving and Restoring Factory Calibration Data 
Files” on page 42.
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Replacement of Disk Drive (Instruments without PC6S/PC7S)
This procedure applies to Removable Disk instruments.

 IMPORTANT Ensure that the Instrument Software Revision on the secondary 
non-classified disk drive matches that of the classified drive in the controlled 
area.

3 Physically deploy instrument into controlled area.

4 Use instrument inside controlled area until cal or repair is needed.

5 Remove main Processor Assembly #1 and retain in controlled area.

For details of how to remove the Processor Assembly, see “Processor Assembly 
Removal Procedure” on page 50.

6 Physically remove instrument from controlled area. Without the Processor Assembly, 
instrument is sanitized.

7 Install secondary non-classified Processor Assembly #2. Note that calibration files 
archived in Step 2 may need to be copied into this Processor Assembly.

8 Instrument is now operational with original calibration data. Deliver to service center 
for cal/repair.

9 Service center generates new calibration files on Disk Drive.

10 Instrument returned to customer’s non-controlled area.

11 Archive calibration files from Disk Drive to read-only portable media.

For details of the procedure, see “Archiving and Restoring Factory Calibration Data 
Files” on page 42.

12 Remove the non-classified Processor Assembly #2 and retain outside of controlled 
area.

For details of how to remove the Processor Assembly, see “Processor Assembly 
Removal Procedure” on page 50.

13 Physically deploy instrument back into controlled area, without a Processor Assembly. 

Bring the read-only media containing the calibration files (created in Step 11) into the 
controlled area.

14 Re-insert classified Processor Assembly #1 into instrument.

15 Restore calibration file (Step 11) from read-only portable media to instrument.

16 Done. Go to Step 4.

Step Task
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If the non–classified drive receives a software upgrade, or if the non-classified 
drive is replaced with a drive that contains a newer revision of software than 
that of the classified drive, the classified drive will require a software upgrade 
(inside the controlled area) to match the non-classified drive.

Items Required

To perform these tasks in a controlled area, you will need:

— 1x Instrument

— 2x Disk Drives for the instrument

One drive (Disk Drive #1) stays permanently within the controlled area, and 
the other (Disk Drive #2) stays permanently outside it

— 1x One-time writable media, plus 1x compatible writing device for the 
non-controlled area and 1x reading device for the controlled area. See 
“Selection of USB Memory Device” on page 42 for details.

Procedure

Steps below that appear on a yellow background take place in the controlled 
area. All other steps take place in a non-controlled area.

  N O T E   The first twelve steps listed below are performed in order to prepare a spare 
drive (Disk Drive #2) that has the same software revision and calibration files, 
and has been used in the same CPU assembly, as the original disk drive (Disk 
Drive #1). 

Step Task

1 Receive new instrument from factory. 

The instrument shipment may include a spare disk drive (additional drive) prepared by 
the factory, which contains the same calibration data and software revision as the disk 
drive in the instrument. If such a factory-prepared disk drive is present, you can skip 
steps 3, 4, 6, 7, 9, and 10 below.

2 Power up the instrument and verify the Instrument Software Revision.

For instructions on how to verify the currently installed Instrument Software Revision, 
see “Determining Instrument Software Revision” on page 43. 

Write down the software revision.

3 If the instrument’s software is not the latest version, update the instrument software to 
the latest version available. For instructions, see “Is your product software 
up-to-date?” on page 3

Write down the software revision.
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4 Back up (archive) the instrument factory calibration data to the USB memory device. 

For details of the procedure, see “Archiving and Restoring Factory Calibration Data 
Files” on page 42.

5 Remove the Disk Drive and SD Memory Card (if present) from the instrument. See “SD 
Memory Card Removal Procedure” on page 57.

6 Replace the original instrument disk drive (Disk Drive #1) with the spare disk drive 
(Disk Drive #2) that was obtained previously. 

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

7 Turn on the instrument with the spare Disk Drive #2 installed. 

8 Verify that the instrument software on the spare Disk Drive #2 has the same revision as 
that on the original Disk Drive #1.

9 If the Instrument Software Revision on the spare Disk Drive #2 is not the same as that 
on the original Disk Drive #1, update the instrument software on this drive to match the 
software revision that you documented in step 3.

For instructions, see “Is your product software up-to-date?” on page 3

10 Restore the instrument calibration data that was previously backed up from the original 
Disk Drive #1. 

For details, see “Archiving and Restoring Factory Calibration Data Files” on page 42.

11 Write the instrument model number, serial number, and software revision on the 
original Disk Drive #1, then reinstall it in the instrument.

12 Write the instrument model number, serial number, and software revision on the spare 
Disk Drive #2, place it back in the static safe bag that it was shipped in, then store it in 
a safe place until it is needed again.

13 The instrument is now ready for use in a secure environment.

14 Physically deploy instrument into controlled area.

15 Use instrument inside controlled area until cal or repair is needed.

16 Make a note of the current software version, because the instrument’s software may 
have been updated inside the secure area. To determine this, press System, Show 
System, and write down the Instrument Software Revision. Attach this note to the 
instrument.

17 Remove Disk Drive #1 and retain in controlled area.

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

18 Physically remove instrument from controlled area. Without the Disk Drive, instrument 
is sanitized.

Step Task
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Replacement of Disk Drive (Instruments with PC6S/PC7S)

 IMPORTANT Ensure that the Instrument Software Revision on the secondary 
non-classified disk drive matches that of the classified drive in the controlled 
area.

19 Install secondary non-classified Disk Drive #2, which was previously prepared in 
Step 12. 

Power on instrument.

20 When the instrument has booted up, press System, Show System, and confirm 
that the Instrument Software Revision is the same as noted in Step 16. If not, upgrade 
the instrument software to the same version as recorded in Step 16. 

21 Instrument is now operational with original calibration data. Deliver to service center 
for cal/repair.

22 Service center may or may not generate new calibration files on Disk Drive, depending 
on whether an adjustment is performed. 

This procedure assumes that new cal data was generated.

23 Instrument returned to customer’s non-controlled area.

24 Verify Instrument Software Revision, to determine whether the service center upgraded 
the software. See Step 2.

25 Back up (archive) calibration file from Disk Drive to portable read-only media.

For details of the procedure, see “Archiving and Restoring Factory Calibration Data 
Files” on page 42.

26 Remove the non-classified Disk Drive #2 and retain outside of controlled area. If 
necessary, update the documented software revision on the drive label.

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

27 Physically deploy instrument back into controlled area, without a Disk Drive. 

Bring read-only media containing calibration file (created in Step 25) into controlled 
area.

28 Re-insert classified Disk Drive #1 into instrument, and verify Instrument Software 
Revision, as in Step 2.

29 If the Instrument Software Revision does not match the revision documented in step 
24 (because the software was updated at service center), then a software update must 
be performed, to force the controlled-area drive to match the non-controlled-area 
drive that was used to calibrate the instrument. 

30 Restore calibration file (Step 27) from read-only media to instrument.

31 Done. Go to Step 15.

Step Task
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If the non–classified drive receives a software upgrade, or if the non-classified 
drive is replaced with a drive that contains a newer revision of software than 
that of the classified drive, the classified drive will require a software upgrade 
(inside the controlled area) to match the non-classified drive.

Items Required

To perform these tasks in a controlled area, you will need:

— 1x Instrument

— 2x Disk Drives for the instrument. 

One drive (Disk Drive #1) stays permanently within the controlled area, and 
the other (Disk Drive #2) stays permanently outside it

Procedure

Steps below that appear on a yellow background take place in the controlled 
area. All other steps take place in a non-controlled area.

  N O T E   The first twelve steps listed below are performed in order to prepare a spare 
drive (Disk Drive #2) that has the same software revision and calibration files, 
and has been used in the same CPU assembly, as the original disk drive (Disk 
Drive #1). 

Step Task

1 Receive new instrument from factory.

The instrument shipment may include a spare disk drive (additional drive) prepared by 
the factory, which contains the same calibration data and software revision as the disk 
drive in the instrument. If such a factory-prepared disk drive is present, you can skip 
steps 3, 4, 6, 7, 9, and 10 below.

2 Power up the instrument and verify the Instrument Software Revision.

For instructions on how to verify the currently installed software revision, see 
“Determining Instrument Software Revision” on page 43. 

Write down the software revision.

3 If the instrument’s software is not the latest version, update the instrument software to 
the latest version available. For instructions, see “Is your product software 
up-to-date?” on page 3

Write down the software version.

4 If software update was performed in step 3, back up (archive) the instrument factory 
calibration data to internal Flash memory. 

For details of the procedure, see “Data Backup or Restore using Alignment Data 
Wizard” on page 47.
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5 Remove the Disk Drive and SD Memory Card (if present) from the instrument. See “SD 
Memory Card Removal Procedure” on page 57.

6 Replace the original instrument disk drive (Disk Drive #1) with the spare disk drive 
(Disk Drive #2) that was obtained previously. 

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

7 Turn on the instrument with the spare Disk Drive #2 installed. 

8 Verify that the instrument software on the spare Disk Drive #2 has the same revision as 
that on the original Disk Drive #1.

9 If the Instrument Software Revision on the spare Disk Drive #2 is not the same as that 
on the original Disk Drive #1, update the instrument software on this drive to match the 
software revision that you documented in step 3.

For instructions, see “Is your product software up-to-date?” on page 3

10 Restore the instrument calibration data that was previously backed up from the original 
Disk Drive #1. 

For details, see “Data Backup or Restore using Alignment Data Wizard” on page 47.

11 Write the instrument model number, serial number, and software revision on the 
original Disk Drive #1, then reinstall it in the instrument.

12 Write the instrument model number, serial number, and software revision on the spare 
Disk Drive #2, place it back in the static safe bag that it was shipped in, then store it in 
a safe place until it is needed again.

13 The instrument is now ready for use in a secure environment.

14 Physically deploy instrument into controlled area.

15 Use instrument inside controlled area until cal or repair is needed.

16 Make a note of the current software version, because the instrument’s software may 
have been updated inside the secure area. To determine this, press System, Show 
System, and write down the Instrument Software Revision. Attach this note to the 
instrument.

17 Remove Disk Drive #1 and retain in controlled area.

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

18 Physically remove instrument from controlled area. Without the Disk Drive, instrument 
is sanitized.

19 Install secondary non-classified Disk Drive #2, which was previously prepared in 
Step 23.

20 When the instrument has booted up, press System, Show System, and confirm 
that the Instrument Software Revision is the same as noted in Step 16. If not, upgrade 
the instrument software to the same version as recorded in Step 16. 

Step Task
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21 Instrument is now operational with original calibration data. Deliver to service center 
for cal/repair.

22 Service center may or may not generate new calibration files on Disk Drive, depending 
on whether an adjustment is performed. 

This procedure assumes that new cal data was generated.

23 Instrument returned to customer’s non-controlled area.

24 Remove the non-classified Disk Drive #2 and retain outside of controlled area. If 
necessary, update the documented software revision on the drive label.

For details of how to remove the Disk Drive, see “Disk Drive Removal Procedure” on 
page 52.

25 Physically deploy instrument back into controlled area, without a Disk Drive. 

26 Re-insert classified Disk Drive #1 into instrument.

If cal files were updated during repair /calibration, a dialog will appear on the 
instrument screen, as shown in Figure 5-1 below, advising you that more recent 
calibration data is backed up to the instrument’s internal Flash memory. You are asked 
whether you wish to restore the calibration data from the internal memory; select Yes.

Figure 5-1 Restore Calibration Data Dialog

Step Task
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27 A further dialog appears, as shown in Figure 5-2 below, asking you to confirm that you 
want to overwrite the current calibration data (presently on the Disk Drive) with the 
backup data stored in the internal Flash memory. The measurement date, time and 
software revision are displayed for each set of calibration data. 

Figure 5-2 Confirm Overwrite Calibration Data Dialog

28 Verify that the software revisions shown in Figure 5-2 are the same. 

If so, select Yes.

If the software revisions displayed in the dialog shown in Figure 5-2 do not match, this 
is probably because the software was updated at the service center. In this case, it is 
highly recommended that you should perform a software update on Disk Drive #1. This 
ensures that the software on controlled-area Disk Drive #1 matches the software used 
on non-controlled-area Disk Drive #2 that was installed when the instrument was 
adjusted and recalibrated. 

29 Done. Go to Step 15.

Step Task
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Archiving and Restoring Factory Calibration Data Files
This section describes how to archive ("back up") the instrument’s factory 
calibration data to an external memory device, or restore the calibration data 
from an external USB Memory Device. The appropriate device type depends 
on your instrument’s environment; for details, see “Selection of USB Memory 
Device” on page 42 below.

The backup and restore procedures differ according to the Instrument Software 
Revision. This section describes the three possible pairs of procedures.

— To determine the instrument software revision, follow the procedure 
“Determining Instrument Software Revision” on page 43 below.

— To determine which backup or restore procedures should be used, 
according to the instrument software revision, see Table 5-5 on page 44.

Selection of USB Memory Device
The appropriate choice of USB Memory Device depends on the circumstances. 
In cases where the calibration data will not need to be brought into a 
controlled area, a USB Flash drive is generally a good choice. 

In cases where the calibration data must be moved into a controlled area, USB 
Flash devices are not permitted. In these cases, a good choice is to back up the 
calibration data to write-once optical media such as a CD-R, DVD±R or BD-R 
disc. 

The optical disc can be written using an external writer device outside the 
controlled area, and then read using a further external reader device situated in 
the controlled area.

Tools Required
To perform backup or restore operations, you need:

— a mouse with a USB interface

— an alphanumeric keyboard with a USB interface

— a portable USB Memory Device. For details, see “Selection of USB Memory 
Device” on page 42.
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Determining Instrument Software Revision

1. On the instrument front panel, press System > Show > System.

2. The Show System display appears, as shown in Figure 5-3 below. Look for the 
Software Revision number specified in the Instrument S/W Revision entry.

Figure 5-3 Show System Display

3. To dismiss the Show System display, press any other front-panel or menu key.
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When you have obtained the Instrument Software Revision number, refer to 
Table 5-5 on page 44 below for the appropriate backup or restore procedure.

Software Revision A.01.55 or Lower
If the instrument software revision is A.01.55 or lower, the calibration data is 
stored in an XML database file. 

Data Backup using XML File

Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB Memory Device into another of the instrument’s USB ports. For details of 
appropriate devices, see “Selection of USB Memory Device” on page 42.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and 
navigate to the following folder: 

E:\AlignDataStorage

5. Copy the following file onto the USB Memory Device: 

CurrentDataSet.xml

Data Restore using XML File

The data can be restored from a USB Memory Device containing the XML 
database file, by using the following process.

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB Memory Device into another of the instrument’s USB ports. For details of 
appropriate devices, see “Selection of USB Memory Device” on page 42.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and 
navigate to a folder on the USB Memory Device containing a previously-saved 
calibration data file named:

Table 5-5 Backup & Restore Procedures for all Instrument Software Revisions

Instrument Software 
Revision

Backup Procedure Restore Procedure

A.01.55 or lower See “Data Backup using XML File” on 
page 44.

See “Data Restore using XML File” on page 44.

Greater than A.01.55; 
lower than A.02.00

See “Data Backup using Utility Program” 
on page 45.

See “Data Restore using Utility Program” on 
page 46.

A.02.00 or greater See “Data Backup or Restore using 
Alignment Data Wizard” on page 47.

See “Data Backup or Restore using Alignment 
Data Wizard” on page 47.
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CurrentDataSet.xml

5. Select the calibration data file, then copy it to the Windows clipboard by selecting 
Edit > Copy from the Windows Explorer pull-down menu.

6. Navigate to the folder below and paste the file by selecting Edit > Paste from the 
Windows Explorer pull-down menu: 

E:\AlignDataStorage

7. Verify that the file CurrentDataSet.xml was copied to the new location.

8. Cycle the instrument power.

Software Revision Greater than A.01.55 and Lower than A.02.00
If the instrument software revision is greater than A.01.55, the calibration data 
is stored in an SQL database file. 

For software revisions greater than A.01.55, but lower than A.02.00, the SQL 
file is written and read by a utility program called BackupAndRestore.exe.

Data Backup using Utility Program

Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB Memory Device into another of the instrument’s USB ports. For details of 
appropriate devices, see “Selection of USB Memory Device” on page 42.

4. Plug the USB keyboard into another of the instrument’s USB ports.

5. Using the mouse double-click on the Windows Explorer icon on the desktop and 
navigate to the following folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

6. Double-click on BackupAndRestore.exe. 

The Calibration Data Backup And Restore dialog shown in Figure 5-4 
appears.

Figure 5-4 Calibration Data Backup
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7. In the group box Specify Backup Folder or File Name use the mouse to press 
the “...” button to open the “Browse For Folder” dialog.

8. In the Browse For Folder dialog, select or create the desired folder on the USB 
memory device, then press OK.

9. Press Backup, then wait for the calibration database to be backed up.

10. When the backup has completed, close the Calibration Data Backup And 
Restore dialog.

Data Restore using Utility Program

Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB Memory Device into another of the instrument’s USB ports. For details of 
appropriate devices, see “Selection of USB Memory Device” on page 42.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and 
navigate to the following folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

5. Double-click on BackupAndRestore.exe: the Calibration Data Backup And 
Restore dialog shown in Figure 5-4 appears.

Figure 5-5 Calibration Data Backup

6. In the group box Specify File To Restore From use the mouse to press the “...” 
button to open the Browse For File dialog.

7. In the Browse For File dialog, select the desired file on the USB memory device, 
then press OK.

8. Press Restore, then wait for the calibration database to be restored.

9. When the restore has completed, close the Calibration Data Backup And 
Restore dialog.

Software Revision A.02.00 or Greater
For software revisions A.02.00 or greater, the calibration data file is read and 
written by the Alignment Data Wizard.
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Data Backup or Restore using Alignment Data Wizard

The Alignment Data Wizard is launched directly from the instrument 
application software interface, so you do not need to exit the application 
software before proceeding. 

Follow the steps below to start the wizard:

1. Plug the mouse’s USB cable into one of the instrument’s USB ports.

2. Plug the USB Memory Device into another of the instrument’s USB ports. For details of 
appropriate devices, see “Selection of USB Memory Device” on page 42.

3. Plug the USB keyboard into another of the instrument’s USB ports.

4. Press System > Alignments > Backup or Restore Align Data...

5. If you are prompted to enter the Administrator password, enter either Keysight4u!, 
or agilent4u, depending on your instrument’s software version.

6. When prompted, press OK to close the analyzer program.

7. The Alignment Data Wizard dialog appears. Its content depends on the 
instrument’s processor type.

If the instrument does not have a PC6S or PC7S Processor Assembly, then the dialog 
is as shown in Figure 5-6 below:
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Figure 5-6 Alignment Data Wizard Dialog

If the instrument has a PC6S or PC7S Processor Assembly, then the Alignment 
Data Wizard dialog contains the selections shown in Figure 5-7 below. 
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Figure 5-7 Alignment Data Wizard Dialog for PC6S/PC7S

In this case, the storage location options are as follows:

— Internal Flash is the Calibration Backup memory in the A4 Processor 
assembly. See item 4 of Table 4-3.

— External Removable Drive. If the instrument has PC6(S) or PC7(S), 
then the default storage location for this option is the SD memory 
card in the A4 Processor assembly. See item 1 of Table 4-3.

To determine your instrument’s Processor Assembly type, see “Determining Installed 
Options” on page 13.

8. Follow the wizard’s on-screen instructions to back up the calibration data to the 
external USB Memory Device or Internal Flash memory, or to restore the data from the 
memory.
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6 Processor Assembly Removal Procedure

To remove the processor board assembly, follow the procedure below, while 
referring to Figure 6-1, which shows the rear panel of instruments with Fixed 
Disk processor assemblies. 

The procedure for instruments with Removable Disk processor assemblies is 
identical, although the appearance of the rear panel differs from that shown in 
Figure 6-1. (For comparative illustrations of the rear panel types, see “Rear 
Panel Configurations” on page 12.)

 CAUTION Before removing the Processor Assembly, ensure that the instrument’s power 
is turned off.

Figure 6-1 Processor Assembly Removal Procedure
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1. Locate and remove the Processor Assembly from the instrument, by removing the 6 
rear panel screws (part number 0515-0372, M3 x 0.5, 8 mm long). 

2. The assembly can be removed from the chassis by pulling it straight out. Use the two 
ejector arms to remove the Assembly from the instrument
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7 Disk Drive Removal Procedure

This chapter describes the procedures for physical removal of the disk drive 
from:

a. Instruments with Non-Removable Drives (generally, older MXA, EXA and CXA 
instruments),

b. Instruments with Removable Drives (generally, all PXA instruments, and newer MXA, 
EXA and CXA instruments).

For detailed information about the drive types installed in each instrument 
type, see the section “X-Series Processor and Disk Drive Configurations” on 
page 8, in the Chapter Products Covered by this Document.

   T I P    Application License keys are stored in EEPROM on the A7 Midplane Assembly 
(as described in Item 3 of Table 4-1 on page 19). Therefore, when replacing 
the Disk Drive, you do not need to back up and restore the license keys.

When installing a replacement Disk Drive, ensure that the instrument 
software revision on the replacement drive matches that of the original drive.
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Instruments with Non-Removable Drives
To remove the disk drive, follow the procedure below, while referring to Figure 
7-1. The numbered items in the figure correspond to the step numbers in the 
procedure.

Before commencing this procedure, remove the complete Processor Assembly 
from the instrument, following the procedure described in the chapter 
Processor Assembly Removal Procedure.

Figure 7-1 Disk Drive Removal Procedure

1. Remove 15 screws from the top lid of the Processor Assembly.

2. Tilt the lid up.

3. While holding the disk drive to prevent it from falling, remove the 4 drive retaining 
screws.
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4. Disconnect the drive cable from the disk drive. 
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Instruments with Removable Drives
To remove the disk drive, follow the procedure below. You do not need to 
remove the Processor Assembly from the instrument before removing the drive.

The numbered items in the figures below correspond to the step numbers in 
the procedure.

 CAUTION Before removing the disk drive, ensure that the instrument’s power is turned 
off.

1. Locate the Processor and Disk Drive Assembly on the instrument’s rear panel, as 
shown in Figure 2-2 in the section “Rear Panel Configurations” on page 12. In Figure 
7-2 below, the processor assembly is shown removed from the rear panel for clarity.

Figure 7-2 Processor Assembly with Removable Disk Drive

2. Locate the removable drive, and its retaining thumbscrew, as shown in Figure 7-2.

3. Turn the thumbscrew to release the drive from the panel, as shown in Figure 7-3 
below. If the thumbscrew is too tight to turn by hand, use a TORX T10 screwdriver to 
loosen it.



Security Features & Document of Volatility                                                                                                         56

Disk Drive Removal Procedure
Instruments with Removable Drives

Figure 7-3 Removable Disk Drive Unit partially extracted (shows SD Memory Card for 
PC6/PC7 Assemblies only)

4. Pull the U-shaped handle attached to the drive unit, to remove the drive from the 
Processor Assembly, as shown in Figure 7-3.
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8 SD Memory Card Removal Procedure

The SD Memory Card is present only in instruments with the PC6 and PC7 
processor assemblies. See “Determining Installed Options” on page 13 for 
details.

When present, the SD Memory Card is located on the A4 Processor assembly. 
However, it can only be accessed after the instrument’s disk drive is removed.

To remove the SD Memory Card:

1. Remove the disk drive by following the “Disk Drive Removal Procedure” on page 52.

Once the disk drive has been removed, the SD Memory Card is accessible.

2. Push in on the SD Memory Card and release. The Card springs back out, and can then 
be removed. Figure 8-1 on page 58 below shows the instrument rear panel, with the 
Disk Drive Assembly and SD Memory Card extracted from the instrument.
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Figure 8-1 Instrument Rear Panel, showing Removable Disk Drive Assembly and SD 
Memory Card

3. Reinstall the disk drive assembly.

Removing the SD Memory Card does not interfere with normal operation of the 
instrument operating system or the instrument application software.
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9 User and Remote Interface Security Measures

This chapter discusses options that are available to you to control and 
configure remote access to the instrument, including:

— SCPI/GPIB Control of Interfaces

— Operating System Security Features

— USB Interfaces. This topic includes information about how to set the 
instrument’s USB ports to read-only.

 IMPORTANT Users are responsible for providing security for the I/O ports for remote 
access, by controlling physical access to the I/O ports. The I/O ports must be 
controlled because they provide access to most user settings, user states, 
and the display memory.

SCPI/GPIB Control of Interfaces
The GPIB command LLO (local lockout) can be sent by the controller to disable 
operation of the instrument’s front-panel keys and softkey menus.

However, sending the LLO command does not disable access to the instrument 
via its USB ports. For details of how to restrict the operation of the USB ports, 
see “Configuring USB for Read-only” on page 64 below.

Operating System Security Features
The instrument’s Windows operating system includes a variety of features that 
you can invoke or modify to enhance system security. These include the 
following:

— The ability to create custom user accounts, and assign different security 
levels to each account by adding it to an existing group. The group types 
predefined by Windows are: Administrator, Power User, User, Backup 
Operator, and Guest, but you can also define new group types.

— To provide additional protection for instruments that have a network (or 
internet) connection, the standard Windows Firewall is enabled by default.
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— You can install standard third-party antivirus and spyware detection 
software designed for use with Windows. If your instrument has a network 
(or internet) connection, this may be advisable.

 CAUTION Running any third-party program while making measurements may adversely 
affect the instrument’s performance.

Details of all these features are provided in the "Windows Security" chapter of 
the Keysight X-Series Signal Analyzer: Getting Started Guide.

Determining the Instrument’s Operating System
You can easily determine your instrument’s operating system version as 
follows:

1. Using the instrument front-panel, press System > Control Panel...

2. The Windows Control Panel appears. From the menu at the top of the Control Panel 
window, select Help > About Windows

3. The About Windows message box appears, displaying the installed version of 
Windows

USB Interfaces
The instrument’s Microsoft Windows operating system can be configured to 
improve the security of the USB interfaces. This section includes the following 
topics:

— “Disabling or Enabling AutoRun/AutoPlay” on page 60

— “Configuring USB for Read-only” on page 64

Disabling or Enabling AutoRun/AutoPlay
AutoRun, and the associated AutoPlay, are Windows features that assist users 
in selecting appropriate actions when new media and devices are detected. 
The AutoRun feature is disabled in the instrument by default, for improved 
security, unless the Administrator account is running. (In Administrator mode, 
AutoRun is enabled, to aid with program installation.)

The procedure for disabling and enabling AutoPlay depends on your 
instrument’s operating system (either Windows 7 or Windows XP). To 
determine the operating system version of your instrument, see “Determining 
the Instrument’s Operating System” on page 60.
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Windows 7

If your instrument has the Windows 7 operating system, you can disable or 
enable AutoPlay via the Control Panel. Open the Control Panel and select 
Hardware and Sound > AutoPlay, then uncheck or check the "Use AutoPlay 
for all media and devices" checkbox.

If you want to understand details of how this AutoPlay setting affects the 
Windows Registry, see the Windows XP discussion below.

Windows XP

You can change the AutoRun configuration by editing the value of one of two 
Windows Registry keys. The Windows Registry is a database that stores critical 
configuration information for the instrument’s operating system.

 CAUTION Exercise extreme caution whenever you edit the Windows Registry. Entering 
an incorrect Registry value, or accidentally deleting Registry keys, may have 
serious consequences that can prevent the system from starting, or require 
that you reinstall Windows. The instructions in “Disable & Enable Procedure” 
on page 62 below assume that you are familiar with the use of the Windows 
Registry Editor to modify Registry settings.

Registry Key Definitions

AutoRun can be configured per-machine or per-user.

  N O T E   If the per-machine Registry key is present, its settings override those of the 
per-user Registry key.

The Registry key that controls the per-machine AutoRun settings is:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Polic
ies\Explorer\NoDriveTypeAutoRun

The Registry key that controls the per-user AutoRun settings is:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\polici
es\Explorer\NoDriveTypeAutoRun

In the following discussions, we use the industry-standard abbreviation HKLM 
for the root key HKEY_LOCAL_MACHINE, and the industry-standard abbreviation 
HKCU for the root key HKEY_CURRENT_USER.

The DWORD value of either of these entries represents a set of single-bit flags. 
Each flag specifies the AutoRun setting for a specific drive type, as shown in 
Figure 9-1. Setting a bit flag to 1 disables AutoRun for that drive type.
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Figure 9-1 AutoRun Flag Definitions for NoDriveTypeAutoRun Registry entry

As shown in Figure 9-1 above, the default Windows XP (post-SP2) and 
Windows 7 value for this entry is 0x91 (under the entry 
HKCU\...\NoDriveTypeAutoRun). This setting disables AutoRun for Unknown 
and Network drives, but enables AutoRun for Removable, Fixed, CD/DVD or RAM 
drives.

You can disable AutoRun for all drive types by changing the value to 0xFF, as 
described in the following section.

Disable & Enable Procedure

In view of the interaction between the per-machine and per-user Registry 
settings, as described above, it is recommended that, if both keys exist in your 
instrument’s Registry, you should alter the settings of both Registry keys to the 
same value at the same time.

Use the following procedure to disable AutoRun for all drive types, or to revert 
all AutoRun settings to their Windows XP or Windows 7 default values. (Note 
that if your instrument has a Windows 7 operating system, there is a simpler 
way to do this via the Control Panel; see “Windows 7” on page 61 above.)

1. Open the Windows Registry editor, using one of the following methods depending on 
your instrument’s operating system:
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a. For Windows XP, select Run... from the Windows Start menu. Then, 
type regedit into the Windows Run dialog box, as shown in Figure 
9-2 below, and click OK.

Figure 9-2 Windows XP Run Dialog

b. For Windows 7, click the Windows Start button at the bottom left of 
the screen, type regedit into the Search programs and files box, as 
shown in Figure 9-3 below, then press Enter.

Figure 9-3 Windows 7 Search edit box

2. The Registry Editor window appears. Using the tree view control on the left of the 
window, navigate to the per-machine (HKLM) key: 
HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explore
r.

3. To disable AutoRun for all drive types, set the value of entry NoDriveTypeAutoRun 
to 0xff.

To revert AutoRun settings to the Windows default values, set the value of 
entry NoDriveTypeAutoRun to 0x91.

4. Again using the tree view control on the left of the Registry Editor window, navigate to 
the per-user (HKCU) key: 
HKCU\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explore
r.

5. To disable AutoRun for all drive types, set the value of entry NoDriveTypeAutoRun 
to 0xff.

To revert AutoRun settings to the Windows default values, set the value of entry 
NoDriveTypeAutoRun to 0x91.
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6. From the Registry Editor menu, select File > Exit to save the settings and exit the 
editor.

7. Shut down and restart the instrument, to enable the new settings to take effect.

Microsoft AutoRun Patch

  N O T E   The information in this section applies only to Windows XP. If your instrument 
has a Windows 7 operating system, you do not require this patch.

There is a defect in Windows XP that compromises the ability to disable 
AutoRun. This defect has been fixed by a patch from Microsoft, as described in 
the Microsoft Knowledge Base Article ID: 967715.

This patch has been included in new instrument shipments from the factory 
since revision A.03.00.

After the patch has been applied, there will be a Registry entry at:

HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\H
onorAutorunSetting with a default value of 1.

More Information

The following Wikipedia articles provide more information about AutoRun and 
AutoPlay:

http://en.wikipedia.org/wiki/AutoRun

http://en.wikipedia.org/wiki/AutoPlay

Configuring USB for Read-only
As from instrument software revision A.04.00, a convenient mechanism is 
provided to set the instrument’s USB interfaces to read-only, thus preventing 
transfer of files from the instrument onto USB devices.

You can change this setting only when you are logged on as the Administrator. 
For details of how to log on to the instrument as the Administrator, see the 
Keysight X-Series Signal Analyzer: Getting Started Guide. To change the 
setting, do the following:

1. If you are not currently logged on to the instrument as the Administrator, you must log 
off.

If you are currently logged on to the instrument as the Administrator, and the Keysight 
XSA application is already running, go to Step 4.

The log-off procedure executes more quickly if you first exit the Keysight XSA 
application, but you can also log off without exiting the application.

2. To log off, use one of the following procedures, depending on your instrument’s 
operating system:

http://en.wikipedia.org/wiki/AutoRun
http://en.wikipedia.org/wiki/AutoPlay
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a. For Windows XP, select Log Off from the Windows XP Start menu 
(as highlighted in Figure 9-4 below), then click Log Off in the Log Off 
Windows dialog that appears.

Figure 9-4 Log Off Button in Windows XP Start Menu

b. For Windows 7, click the Windows Start button, then select Shut 
down > Log off from the Windows Start menu, as shown in Figure 
9-5 below.

Figure 9-5 Windows 7 Log off Control

3. After you have logged on to the instrument as the Administrator, restart the Keysight 
XSA application. 

4. When the XSA application has fully initialized (that is, when the main results view and 
softkey menu are visible), press the System front-panel key.

5. From the System softkey menu, select: More > Security > USB.

6. Select the option Read Only.

7. To activate the configuration change, either log out and then back in under your usual 
user name (which by default is "instrument"), or cycle the instrument power.
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10 Procedure for Declassifying a Faulty Instrument

Even if the instrument is not able to power on, it may be declassified by:

1. Removing the disk drive from the instrument, using the appropriate procedure as 
described in “Disk Drive Removal Procedure” on page 52.

2. Removing the SD Memory card (if present), using the procedure described in “SD 
Memory Card Removal Procedure” on page 57.
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11 Special Options

You can install certain special options that provide security-related 
functionality. The following available options are described in this chapter.

— “Option SF1” on page 68

— “Option SF2” on page 69

To determine which of these options, if any, are installed in your instrument, 
use the procedure described in “Determining Installed Options” on page 13.
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Option SF1
Option SF1 is a license key-enabled special option that addresses the 
requirements of security-conscious users. Installing Option SF1 in the 
instrument causes changes to available functionality in certain menus, and 
suppression of certain SCPI commands, to prevent the launching of Windows 
programs from the instrument application. This reduces the instrument’s 
vulnerability to the effects of unauthorized or undesirable third-party programs 
or scripts.

This section summarizes the functional modifications to the instrument 
capabilities when Option SF1 is installed.

Menu & Command Changes
Installing Option SF1 causes the following menu and command changes in the 
instrument.

File Menu

In the File menu, the File Explorer key is not available.

System Menu

In the System menu, the keys Control Panel..., and Web Browser are not 
available.

In the System > Service menu, the keys Front Panel Test..., Front Panel Pixel 
Test..., and Front Panel Touch Test... are not available.

In the System > Licensing menu, the key License Manager... is not available.

SCPI Commands

The SCPI command :SERVice[:PRODuction]:RUN is not available.
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Option SF2
Option SF2 is a license key-enabled special option that addresses the 
requirements of security-conscious users who need to be able to prevent the 
saving of measurement results or user configurations to the instrument’s disk 
drive while in the instrument application. The option also prevents the recall of 
results and configurations from the disk.

Installing Option SF2 makes the following changes to the instrument’s 
operating environment:

— Modifies aspects of the Windows operating system, specifically to disable 
memory page file usage. For details, see “Operating System Changes” on 
page 69.

— Disables certain menu keys and SCPI commands, eliminating the ability to 
save or recall user data. For details, see “Menu & Command Changes” on 
page 69.

Operating System Changes
Installing Option SF2 disables Windows memory page files. The reason for this 
change is to ensure that memory page swapping does not inadvertently cause 
the instrument to create on-disk copies of RAM data.

Note that one effect of disabling memory page files is to reduce the available 
memory space for preloading applications at power-on.

   T I P    If a disk recovery and software update is performed, memory paging files will 
automatically be re-enabled. If the X-Series application is then started (with 
Option SF2 installed), an advisory dialog appears, describing how to disable 
the page files.

The X-Series application will not start until memory page files are disabled. 
For details of how to run SF2RegSetup.reg, refer to Installation Note: Keysight 
X-Series Signal Analyzers Option SF2.

Menu & Command Changes
Installing Option SF2 causes several menu and command changes in the 
instrument, as follows.

Front-panel Keys

The functions of the following front-panel keys are disabled. Pressing one of 
these keys displays the informational message “Settings conflict; Feature not 
available for Option SF2”.

— Quick Save

— Recall
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— Save

  N O T E   Save and Recall are often used with the N9069C Noise Figure Measurement 
Application to allow multiple noise sources to be used without the need to 
re-enter ENR values or to perform the noise source calibration each time a 
different noise source is connected. When Option SF2 is installed, this 
functionality is not available.

File Menu

The Page Setup, Print, Quick Save, Recall and Save icons are not available.

Preset Menu

The User Preset, Save User Preset, and User Preset All Modes icons are not 
available.

System Menu

In the System > Power On menu, the Power On Type selection keys (Mode 
Preset, User Preset and Last State) are not available.

Disabled SCPI Commands

The following SCPI commands are not available. Attempting to use any of 
these commands generates the Error message: –113,”Undefined header".

Note that some of the commands listed are specific to individual applications, 
thus the set of available commands depends on which applications are 
licensed for a given instrument.

IEEE 488.2 Common Commands (*)

— *RCL

— *SAV

MMEMory Subsystem

— :MMEMory:CLEar:ALL

— :MMEMory:CLEar:STATe

— :MMEMory:COMMent

— :MMEMory:COPY:DEVice

— :MMEMory:INITialize

— :MMEMory:LOAD:ALIMit

— :MMEMory:LOAD:ALISt

— :MMEMory:LOAD:ATRace

— :MMEMory:LOAD:AUTO
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— :MMEMory:LOAD:AXConfig

— :MMEMory:LOAD:CAPTured

— :MMEMory:LOAD:CCORrection

— :MMEMory:LOAD:CHTable

— :MMEMory:LOAD:CORRection

— :MMEMory:LOAD:CORRection:DDIRectory

— :MMEMory:LOAD:CORRection:GROup

— :MMEMory:LOAD:DLISt

— :MMEMory:LOAD:DPD:REFerence:DATa

— :MMEMory:LOAD:DPD:REFerence:SRATe?

— :MMEMory:LOAD:DTRaces

— :MMEMory:LOAD:ENR

— :MMEMory:LOAD:EVMSetup

— :MMEMory:LOAD:FMT

— :MMEMory:LOAD:FREQuency

— :MMEMory:LOAD:IQRef

— :MMEMory:LOAD:LIMit

— :MMEMory:LOAD:LIMit:DDIRectory

— :MMEMory:LOAD:LOSS

— :MMEMory:LOAD:MASK

— :MMEMory:LOAD:MPADapter:CORRection

— :MMEMory:LOAD:PDATa

— :MMEMory:LOAD:PSET

— :MMEMory:LOAD:RDATa

— :MMEMory:LOAD:RECording

— :MMEMory:LOAD:REGister

— :MMEMory:LOAD:SCAN

— :MMEMory:LOAD:SCONfig

— :MMEMory:LOAD:SETup

— :MMEMory:LOAD:SLISt

— :MMEMory:LOAD:SSSetup

— :MMEMory:LOAD:STATe
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— :MMEMory:LOAD:STATe:VSA

— :MMEMory:LOAD:T2Config

— :MMEMory:LOAD:TMMConfig

— :MMEMory:LOAD:TRACe

— :MMEMory:LOAD:TRACe:DATA

— :MMEMory:LOAD:TRACe:REGister

— :MMEMory:LOAD:VSASetup

— :MMEMory:LOAD:ZMAP

— :MMEMory:MSIS

— :MMEMory:NAME

— :MMEMory:NFIGure:LOAD:ENR

— :MMEMory:NFIGure:LOAD:FREQuency

— :MMEMory:NFIGure:LOAD:LOSS

— :MMEMory:NFIGure:STORe:ENR

— :MMEMory:NFIGure:STORe:FREQuency

— :MMEMory:NFIGure:STORe:LOSS

— :MMEMory:REGister:STATe:LABel

— :MMEMory:REGister:STATe:LABel:MAXimum?

— :MMEMory:REGister:STATe:MAXimum?

— :MMEMory:REGister:TRACe:LABel

— :MMEMory:REGister:TRACe:LABel:MAXimum?

— :MMEMory:REGister:TRACe:MAXimum?

— :MMEMory:RESults:CORRection:MODE

— :MMEMory:RESults:LIMits:MODE

— :MMEMory:RESults:OUTPut

— :MMEMory:RESults:SCAN

— :MMEMory:RESults:SCReen:THEMe

— :MMEMory:RESults:SLISt

— :MMEMory:RESults:TRACe:DATA

— :MMEMory:RESults:TRACe:HEADer

— :MMEMory:RESults:TRACe:SETTing

— :MMEMory:RMEDia:LABel
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— :MMEMory:RMEDia:LIST?

— :MMEMory:RMEDia:SIZE?

— :MMEMory:RMEDia:WPRotect?

— :MMEMory:SELect[:ITEM]:ALL

— :MMEMory:SELect[:ITEM]:DEFault

— :MMEMory:SELect[:ITEM]:HWSettings

— :MMEMory:SELect[:ITEM]:LINes:ALL

— :MMEMory:SELect[:ITEM]:NONE

— :MMEMory:SELect[:ITEM]:SCData

— :MMEMory:SELect[:ITEM]:TRACe[:ACTive]

— :MMEMory:SELect[:ITEM]:TRANsducer:ALL

— :MMEMory:STORe:ALIMit

— :MMEMory:STORe:ALISt

— :MMEMory:STORe:ATRace

— :MMEMory:STORe:AXConfig

— :MMEMory:STORe:CAPTured

— :MMEMory:STORe:CHTable

— :MMEMory:STORe:CORRection

— :MMEMory:STORe:CORRection:GROup

— :MMEMory:STORe:CPData

— :MMEMory:STORe:DLISt

— :MMEMory:STORe:DTRaces

— :MMEMory:STORe:ENR

— :MMEMory:STORe:FMT

— :MMEMory:STORe:FREQuency

— :MMEMory:STORe:IQRef

— :MMEMory:STORe:LIMit

— :MMEMory:STORe:LOSS

— :MMEMory:STORe:MPADapter:CORRection

— :MMEMory:STORe:PSET

— :MMEMory:STORe:QSAVe

— :MMEMory:STORe:RDATa
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— :MMEMory:STORe:RECording

— :MMEMory:STORe:RESults

— :MMEMory:STORe:RESults:DATA

— :MMEMory:STORe:RESults:MTABle

— :MMEMory:STORe:RESults:PTABle

— :MMEMory:STORe:RESults:SNGLS

— :MMEMory:STORe:RESults:SPECtrogram

— :MMEMory:STORe:RESults:TABLe:CUMulative

— :MMEMory:STORe:RESults:TABLe:CURRent

— :MMEMory:STORe:RESults:TABLe:PDW

— :MMEMory:STORe:RESults:TABLe:PDW:FULL

— :MMEMory:STORe:RESults:TABLe:PULSe

— :MMEMory:STORe:RESults:TABLe:PULSe:FULL

— :MMEMory:STORe:RESults:TABLe:VPDW

— :MMEMory:STORe:RESults:TABLe:VPDW:FULL

— :MMEMory:STORe:SCAN

— :MMEMory:STORe:SCONfig

— :MMEMory:STORe:SCReen

— :MMEMory:STORe:SCReen:THEMe

— :MMEMory:STORe:SLISt

— :MMEMory:STORe:STATe

— :MMEMory:STORe:T2Config

— :MMEMory:STORe:TMMConfig

— :MMEMory:STORe:TRACe

— :MMEMory:STORe:TRACe:DATA

— :MMEMory:STORe:TRACe:REGister

— :MMEMory:STORe:ZMAP

— :MMEMory:TRACe:CLIent

— :MMEMory:TRACe:CLIent:STATe

— :MMEMory:TRACe:LOGO:FILE

— :MMEMory:TRACe:LOGO:STATe

— :MMEMory:TRACe:OPERator
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— :MMEMory:TRACe:OPERator:STATe

— :MMEMory:TRACe:PDEScription

— :MMEMory:TRACe:PDEScription:STATe

— :MMEMory:TRACe:TITLe

— :MMEMory:TRACe:TITLe:STATe

SYSTem Subsystem

— :SYSTem:PON:TYPE

— :SYSTem:PRESet:SAVE

— :SYSTem:PRESet:TYPE

— :SYSTem:PRESet:USER

— :SYSTem:PRESet:USER:ALL

— :SYSTem:PRESet:USER:SAVE

— :SYSTem:PRINt:THEMe
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A: References

Some items below provide links to non-Keysight URLs. Please note that such 
links are subject to deletion or change without notice. In case of the failure of 
any such link, please contact the specified third party.

1. Defense Security Service (DSS) Assessment and Authorization Process Manual 
(DAAPM)

Defense Security Service. Version 2.0, May 6, 2019

May be downloaded in PDF format from:

https://www.dcsa.mil/Portals/69/documents/io/rmf/DSS_Assessment_and_Autho
rization_Process_Manual_Version_2.0.pdf

2. NIST SP 800-88, Revision 1, Guidelines for Media Sanitization

National Institute of Standards and Technology. December 17, 2014 

May be downloaded in PDF format from:

http://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-88r1.pdf

3. Keysight X-Series Signal Analyzer: Getting Started Guide

Keysight Technologies 2008-2019. Part Number: subject to change as document is revised.

A printed copy of this document is supplied with each Keysight X-Series Analyzer. 

It is also available in Acrobat (PDF) form: 

— on the Documentation DVD supplied with each instrument,

— via download from:

http://www.keysight.com/find/xseries_getting_started_guide_windows7

4. Microsoft Knowledge Base Article ID: 967715

"How to disable the AutoRun functionality in Windows": may be viewed at:

http://support.microsoft.com/kb/967715

Note that a second article, at: http://support.microsoft.com/kb/953252, "How to correct 
’disable AutoRun registry key’ enforcement in Windows", redirects to article ID 967715.

5. Installation Note: Keysight X-Series Signal Analyzers Option SF2

Keysight Technologies 2018. Part Number: N9020-90234.

May be downloaded from:

http://literature.cdn.keysight.com/litweb/pdf/N9020-90234.pdf

https://www.dcsa.mil/Portals/69/documents/io/rmf/DSS_Assessment_and_Authorization_Process_Manual_Version_2.0.pdf
https://www.dcsa.mil/Portals/69/documents/io/rmf/DSS_Assessment_and_Authorization_Process_Manual_Version_2.0.pdf
http://literature.cdn.keysight.com/litweb/pdf/N9020-90234.pdf
http://support.microsoft.com/kb/967715
http://support.microsoft.com/kb/953252
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